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1.

Safety Message

CAUTION!
It is necessary to remove the cover of the 400
Series Spectrophotometer for some procedures
described in this manual. In some cases, power
to the instrument must be applied while
adjustments are made. There are two regions of
the instrument power supplies that are shielded
and marked where dangerous voltages exist.
Avoid touching any components behind these
shields. If the shields are removed for any
reason, re-install them before power is applied
to the instrument.
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2.

Introduction

The S.I. Photonics 400 Series Spectrophotometers are laboratory instruments
that utilize the latest solid state CCD array detector technology. The optical
system is specifically designed to be used with fiber optic sampling accessories.
A variety of probes and probe configurations are available for different sample
requirements.
The instrument consists of tungsten and deuterium (on model 420 and 440 only)
light sources, optical shutters for the light sources, a spectrograph with integrated
CCD array detector, and the detector control electronics.
The tungsten source is part of the main power supply printed circuit board. The
lamp is a miniature quartz-halogen type. The lamp output is optically regulated
using a photodiode detector and feedback circuit. The lamp power supply also
features over-current protection during both lamp start-up and operation. The
tungsten lamp is used for the 350 to 980 nm range when the deuterium lamp is
not used, and from 380-460 to 980 nm when the deuterium lamp is used.
The deuterium lamp is a high output and long life unit capable of 4000 hours of
operation. The lamp bulb is pre-aligned to a flange, which makes changing the
lamp a simple operation. The lamp power supply on and off functions are
performed under software control so that the lamp is turned on only when the
user needs to acquire data in the 190 to 460 nm range.
The spectrograph is a sealed all-reflective optics system, using a single mirror for
collimating and focusing, and a 325-line/mm diffraction grating blazed at 300 nm.
An integrated, fixed order-sorting filter is used to eliminate second order
radiation. The spectrograph optics, CCD array detector, and detector electronics
are enclosed in an insulated, temperature regulated enclosure to ensure high
baseline stability.
A digital signal processor is used in the 400 series instrument to execute the
commands issued by the host computer. This very high speed 24 bit processor
directly generates the timing states necessary for CCD readout, sums the data
from multiple CCD reads, and controls other devices in the spectrophotometer
such as optical shutters and deuterium lamp power relays. The processor has
an integrated serial communications interface that is used to transfer command,
status, and data information between the spectrophotometer and the host
computer.
This User's Manual covers the installation, use, and maintenance of the S.I.
Photonics 400 Series Spectrophotometers. It is valid for models 410, 430
(tungsten lamp source only) and 420, 440 (tungsten and deuterium lamp
sources).
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2.1 Items Included in 400 Series Systems
Basic items shipped with your instrument are listed below, see the packing slip
for a detailed list.
1)

AC power cord

2)

6' long DB9M to DB9F RS-232 cable

3)

DB9M to DB25F adapter

4)

Fiber optic sampling accessory

5)

User’s manual

6)

Software installation CD-ROM

7)

Spectrophotometer

8)

Spare tungsten lamp

9)

Trimpot adjustment tool

10)

Hex wrenches (2)

Verify the contents of the shipping container and notify S.I. Photonics if any items
are missing. We can be reached at (520)293-6911 or via the internet at
www.si-photonics.com
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3.

Technical Assistance, Service, and Spare Parts

If it is necessary to contact S.I. Photonics for support, please have ready the
instrument model number, serial number, or optics serial number and control
software revision number. Print out the About Spectrometer window from the
Help menu for the information. The model and serial numbers can also be
located on labels on the inside of the instrument base. The software revision
number is printed on the distribution CD label and can also be found in the View
menu of the main front panel under VI info.

Figure 3-1 About Spectrophotometer Window
Replacement parts for the 400 Series Spectrophotometers are:
Part Number
1991

Description
Lamp, Tungsten, Quartz

1103

Lamp, Deuterium

The tungsten lamp is part number Thorn M29 (product no. 72170T) distributed by
Microlamp, Ft. Lauderdale, Florida and may also be purchased directly from
them. It is recommended to have a spare tungsten lamp.
For technical support and to order supplies and replacement parts contact the
Service Department at (520) 293-6911 or via email at support@si-photonics.com.

5

4.

Quick Installation Instructions

This section is for those who either enjoy the challenge of setting up a new
instrument without reading the manual, or do not have the patience to read a
manual thoroughly before plunging in. If you are this type of person, and you
have experience installing scientific instruments and Windows software, read this
section to get up and running quickly. Then, when the excitement has worn off or
you get stuck, go back and thoroughly read the manual. For those persons that
are more cautious, read the manual Sections 5 through 8, then follow the
instructions to get the instrument operational before continuing with the detailed
software description.
Before you plug in AC power to the instrument, remove the cover by loosening
(not removing) the four screws on the ends. If you are using 220VAC power, the
power selection switch (located near the main power switch on the main power
supply board) must be switched and the fuse value changed.
Install the probe holder by sliding it onto the probe stand. If equipped with a
probe, install the fiber optic probe next. Make sure that the ends of the fiber
connectors are clean (wipe with alcohol and lens paper), and that the SMA
connectors are plugged into the right places. A nylon-tipped setscrew is used to
hold the connector ferrules in the sleeves. Tighten the setscrews using the
supplied hex (Allen) wrench. Replace the cover on the spectrometer and attach
the AC power cord. Connect the RS-232 port on the spectrometer to an unused
port on the host computer.
Install the software in windows. When the CD is loaded the program install
should automatically start. If the install does not start automatically, execute the
SETUP.EXE on the CD-ROM and follow the directions. If you are unsure about
what hardware you need to run the application, refer to Section 0.
Once installation is complete, start the SI400 application, and turn on the
spectrophotometer power. The tungsten lamp should immediately light, but the
deuterium lamp on model 440 instruments will not light until commanded by
software.
Click the OK box to initialize the instrument. If the instrument is not
communicating with the host computer, an error message will pop up. To correct
error pull down the Operate menu from the main screen and click on the
Configure option. Refer to section 14 for instruction to adjust light intensity
errors.
Select the COM port that you are using on the computer. Leave the baud rate
set to 38,400, as the spectrometer is shipped with this baud rate. Choose printer
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type, Monochrome or Color. Click the Save button to keep any changes, and
then select from the Operate menu the Initialize item.
At this point, if everything has gone just right and the computer and
spectrophotometer are communicating, you should hear a faint click-clack from
the tungsten lamp shutter. Also, the Blank button in the upper right corner of the
screen will change from a light gray inactive mode to a red active mode. The
Setup file is automatically read from the hard drive and the operating parameters
of the spectrometer will be set. The parameters include the wavelength range
and the lamp crossover wavelength. The wavelength scale on the main
spectrum display will reflect the wavelength range. At this point, the wavelength
range and lamp crossover wavelength can be changed if desired by selecting
the Wavelength Range item, which is located in the Operate menu. If you have
a model 440 instrument and choose a minimum wavelength below the lamp
crossover wavelength, (460 nm is the initial default), you will be asked if you want
to turn on the deuterium lamp.
If you get error messages instead at this point, follow the advice of the error
messages. If this does not help, read Section 16 of the manual.
Once the spectrophotometer is operating, immerse the probe in water, and start
pushing buttons. The Blank takes a blank spectrum, and Sample takes a
sample spectrum and records the results on the screen. Most of the buttons are
self-explanatory in the usual Windows fashion. The Quantitative Item in the
Operate menu, brings up a new screen for quantitative analysis. The Timed
Acquisition item in the Operate menu opens a new screen where entire spectra
or discrete wavelengths can be acquired at set time intervals. The Multi Spectra
Display item can be accessed from the View Menu and allowing up to 10
spectra to be viewed and manipulated.
When you are ready for more detail read the manual Sections 7 through the end.
This way you will be able to use the software to its fullest capabilities, and
change lamps and adjust lamp intensity when the need arises.
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5.

Setup of the 400 Series Spectrophotometer

The 400 Series Spectrophotometer includes a fiber optic probe that is not
connected during shipment. It is necessary to connect the probe in order to
conduct the initial system tests. The probe stand and sliding probe holder is
designed to conveniently hold the probe when it is not in use, or when sampling
the contents of small containers. It is not essential for the operation of the
spectrophotometer and may be removed if desired.

5.1

Removing the Cover

The spectrophotometer cover must be removed to install the probe. Before
starting, make sure that the AC power cable is disconnected where it enters the
instrument. Next, locate the four cover screws, two on each end of the
instrument. Using a Phillips screwdriver, loosen the four screws approximately 5
turns, or 1/8". The screws should not be removed. Next, lift the cover straight
up until it clears the internal components, and
set it aside.
BAUD rate table
BAUD rate
jumpers
RS-232 connector
Fuse holder

Spectrograph

AC power connector
Power switch
Voltage selection
switch

External lamp connector

Cooling
fan
D2 power supply
(only models
420/440)

External shutter connector
D2 lamp
housing

W lamp housing
Input

Figure 5-1 Main compartment of the 440 Series Spectrophotometer
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5.2

Inside the Spectrophotometer

Inside the spectrophotometer is a compact spectrograph (which is thermally
insulated for temperature stability), a digital electronic controller card, and the
main and optional deuterium lamp power supplies as shown in Figure 5.1.

5.2

Initial Inspection

With the cover removed, inspect the inside of the spectrophotometer for any
parts that may have vibrated loose during transit.

5.3

AC Voltage Selection

The spectrophotometer is configured to operate from 100 to 120VAC mains
when delivered from the factory. If the instrument is to be operated from 220VAC
mains, the AC voltage selection switch must be changed. This switch is located
beneath a guard near the power switch. The switch is accessible through a hole
in the guard. A small flat blade screwdriver is used to change the switch setting.

5.4

Installation of Probe Holder

To install the probe holder on the probe stand rod, squeeze the flat metal spring
stop slightly and slide it first over the rod end. The black plastic surface should
now be on top.

5.5

Installation of Fiber Optic Sampling Accessories

All sampling accessories for the 400 Series Spectrophotometer are fiber optically
coupled to the instrument. Each accessory will have either two (UV only or
Visible only) or three (UV/Visible) fiber optic connectors. The standard probe
supplied with the 400 series instrument is a fiber optic dip probe. Also available
with the instrument are the Universal Fiber Optic Sampling Bench, which can be
fitted with a cuvette holder or optical filter holder, and a fiber optic reflectance
probe.
The 400 series instruments are designed to be used with probes terminated with
standard SMA type connectors, such as the standard fixed path length dip
probes. The connectors are not attached to the instrument in the conventional
manner of tightening the retaining nut, but rather the connector ferrule is clamped
in place using a nylon-tipped setscrew. This approach was taken to ensure a
more mechanically stable connection. It is important to use only the supplied
nylon tipped setscrews to clamp the connector ferrules. Standard setscrews will
damage the ferrule, and possibly break the fiber inside the connector.
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Fiber optic probes are fragile in some operations. Use caution with the probe as
damaged probes can not be easily repaired; replacement is usually the only
alternative. The fiber optics in the probe are fragile and can be broken if
mishandled by placing too great of tensile stress, by exerting too small of bend
radius on the cable sheath, or by kinking or crushing the sheath. Never swing
the probe from the fiber optic sheath, or pull on the probe when attached to the
spectrophotometer such that the sheath is stretched tight.

5.6

Fiber Optic Probe Installation

The fiber optics at the connectors must be clean, free of dust and especially
fingerprints (to avoid UV absorption) before they are installed. Use lens tissue
moistened with isopropanol to clean if necessary.
To install any of the sampling accessories, locate the small hex (Allen) wrenches
provided with the instrument. Remove the plugs in the spectrometer where the
fibers attach, and remove the caps from the ends of the fiber optic ferrules. Take
care not to scratch or damage the ends of the fiber optics when the protective
caps are removed. Insert the W source fiber into the W source bushing until it
stops and secure it with the setscrew. Install the Input fiber (and for model
420/440 instruments, the D2 source fiber) in the same manner.

5.7

RS-232 Communications Link

The communications channel between the host computer and the 400 Series
Spectrophotometer is an RS-232 serial link. Information passed over this link
includes commands to operate light shutters, initiate the CCD array detector
readout, turn on or off the optional deuterium lamp, etc. The link is also used to
pass the light intensity as a function of wavelength information used to determine
the optical transmission or absorbance of a sample. One important task for the
communications link is to initialize the spectrophotometer by passing a software
program to its microprocessor. This task must be accomplished before the
spectrophotometer can recognize any commands or perform any functions.

5.7.1 Configuring the Communications Link
In order for the communications link to pass information, it must be properly
configured involving both the physical cabling of the host computer COM port to
the spectrophotometer, and ensuring that the two pieces of equipment are
communicating at the same data rate, or baud rate. All other communications
parameters, such as number of data bits, parity bits, etc. are permanently
configured in the spectrophotometer, and are configured in the host computer by
the SI400 application without the need for user intervention.
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5.7.2

RS-232 Cable

The communications cable must be a high-quality, shielded cable intended for
RS-232 use, such as the one supplied with the instrument. This is especially
critical when higher baud rates (19,200 and higher) are used. The cable supplied
with the 400 series instruments is a 6' DB9 male to DB9 female, wired straight
through (pin 1 to pin 1, pin 2 to pin 2, etc.) which can be connected to a DB9
male COM port connector on the host computer. A DB25 female to DB9 male
adapter is also supplied to allow connection to a DB25 male serial port on the
host computer. It is possible to use a longer cable, however it may be necessary
to use a lower baud rate to ensure reliable communications.
Connect one end of the cable to the spectrophotometer and the other to any
unused COM port on the host computer configured as COM1, COM2, COM3, or
COM4. If all COM ports on the computer are in use, it may be necessary to add
a COM port connector or interface card. It is important that the COM port to be
used is not sharing an interrupt. Refer to your computer equipment supplier for
information.

5.7.3

Baud Rate Selection

It is advantageous to use as high a baud rate for the communications link that
reliably works as spectral data will be transferred from the spectrophotometer
and be displayed or analyzed faster. Under some conditions it may be
necessary to decrease the baud rate to ensure reliable communications with
some host computers.
The COM ports for most modern PC compatible computers are capable of
reliable operation at baud rates of at least 19,200 if the cable length is kept short.
If it is necessary to use a cable of approximately 15' or greater between the host
computer and the spectrophotometer, or if an older PC computer that can not
support 19,200 baud is used, it will be necessary to decrease the baud rate to
9,600. If the host computer is capable of communicating at 38,400 baud or
higher, and only the 6' cable supplied with the instrument is used, it may be
advantageous to increase the baud rate.
The baud rate for the 400 Series Spectrophotometers is set to 38,400 at the
factory. With a 16550 UART serial port, baud rates up to 57,600 are possible
To change the baud rate, it is necessary to remove the cover of the
spectrophotometer (Refer to Section 5.1 Removing the Cover) and change the
baud rate jumpers. The jumpers are on the controller board near the RS-232
connector. There are 3 pairs of pins emerging from a small block labeled JP1,
JP2, and JP3. A plastic plug containing a wire fits down over a pair of pins
electrically connecting them (Closed or 1) or is removed or pushed down over
only one pin (Open or 0). Select the desired baud rate by positioning the
12

jumpers as shown in the table 5-1 below.
controller board near the spectrograph.

This table is also printed on the

JP3

JP2

JP1

BAUD Rate

0

0

0

9600

0

0

1

19200

0

1

0

38400

0

1

1

57600

1

0

0

115200

1

0

1

230400

1

1

0

460800

1

1

1

921600

Table 5-1 Baud Rate Jumper Table

Table 4-2 Configuration Pull Down Menu
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5.8

Spectrograph Warm-up

At this point, the spectrophotometer cover is ready to be replaced. Follow the
cover removal procedure in reverse order, then connect the AC power cord
supplied to the instrument and to a standard 110VAC wall outlet.
The spectrograph in the 400 series instruments is temperature regulated at
approximately 35oC to improve baseline stability.
A warm-up time of
approximately 30 minutes is required for the temperature of all optical elements
to equilibrate. During this time, the baseline will drift. If careful measurements
are to be made, or if long periods between blank and sample acquisition are
anticipated, temperature equilibration and warm-up is essential.
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6.

Software Installation

The host computer using the SI400 series application software controls the 400
Series Spectrophotometer. This software system operates in the Windows 95 or
later environment and conforms to normal Windows operating conventions
whenever they apply. Users unfamiliar with the Windows environment should
refer to the "Getting Started with Microsoft Windows" and "Microsoft Windows
User's Guide" that is part of the Windows distribution package before proceeding.

6.1 Host Computer Hardware and Software Requirements
The SI400 control application runs under Windows 95, 98, NT, 2000 and XP
operating systems. Minimum hardware requirements include:
1) a Pentium 90 CPU
2) a hard disk drive with a minimum of 6 MB free space
3) a CD-ROM Drive or 1.44 MB 3.5" floppy drive
4) a two-button mouse (or a three button mouse in two-button mode)
5) a minimum of 32 MB RAM
6) one RS-232 serial port equipped with a 16550 buffered UART configured as
COM1, COM2, COM3, or COM4 using the standard Windows addresses
and interrupt vectors. The port can have either a DB9 or DB25 male
connector.
**Alternatively, an RS-232 to USB conversion cable is available for PC
configurations utilizing USB input.
A VGA monitor with a minimum 800 X 600 resolution is required.
Throughout this manual, a basic knowledge of the Windows environment and its
conventions is assumed. If necessary, refer to the Windows User's Manual for
guidance.

6.2 Installing the SI400 Control Software
The SI400 Control Software is distributed in compressed form on a CD-ROM.
The files must be installed onto your hard disk drive using and Setup program on
the CD-ROM from Windows. Disks can be made from the CD-ROM – Call S.I.
Photonics for instructions.
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6.3

Windows 9X, NT, 2000 and XP

To install, insert the CD-ROM into your drive.
The install set-up window should open automatically, if not, go to the Start Menu
and click on Run. Type in CD-ROM drive designation (i.e. D: ) A window will
appear Click on SET UP.
Press the Install button and follow the prompts to complete the installation.
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7.

The SI400 Control Software

The SI400 software application uses the Virtual Instrument (VI) concept where
the various buttons, knobs, dials, displays, and controls that you would expect to
find on an instrument along with pull down menus have been replaced by their
graphical equivalents that appear on the computer screen. The instrument
hardware no longer has physical controls, but the combination of computer
screen, keyboard, and mouse have replaced their function in ways that can be
easily optimized for specific tasks. Different front panels can exist to perform
different functions for the same physical hardware! The SI400 application has
different front panels for general data acquisition, quantitative data acquisition,
and for acquiring data at fixed time intervals, each optimized for the task.

7.1

Starting the SI400 Application

During installation a program group was created and can be accessed in
Windows 95/98/NT/2000 and XP from the Programs item on the Start menu. To
start the application, SI 400 program group icon, then double click on the SI400
application icon. If you do not select to have a program group created, execute
the SI400.exe program using the file manager.
When the SI400 application is started, it presents the main VI front panel that
appears (see Figure 6-1 Main front panel) to have an assortment of buttons and
other digital controls and drop down menus, along with a graphical display of
optical absorbance , transmission or reflectance. The buttons are "pressed" by
using the mouse to point to the button, and pressing the left mouse button. If a
button is active, it will react when pressed so that it looks like it was pressed, and
that some activity is being performed.
There are times when a button cannot become active until some other function is
first performed. For example, the Blank button is inactive until the instrument is
initialized. The Sample button is inactive until a blank has been acquired. When
a button is inactive, it is a light gray, semitransparent color.
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Figure 7-1 Main front panel

Another type of control on the front panel is used to select between a fixed set of
options. This type of control will always have selection arrows on the left side of
the control. For example, there is a control on the right side of the graphical
output display that is used to select the display mode between absorbance,
transmission, reflectance, intensity, and blank intensity. When the mouse is
positioned over this type of control and the left mouse button pushed, the
different possible choices will appear on the screen. The selected choice is
highlighted. To change the selection, move the mouse forward and backward
until the desired option is
highlighted, then release the
mouse button.
There are times when numerical
information or text must be
entered with the keyboard. An
example is entering comments for
a spectrum. For these types of
controls, position the mouse
pointer over the control and press
18

Figure 7-2 Menu

the left button. A cursor will appear, and you can enter information in the area
provided much as you would with a word processor. The delete key will delete
text, the left, right, up, and down arrows will move the cursor, and other keys will
enter text. When you are finished entering information, do not hit the return key,
but just move the mouse pointer to another location and operate another control.

7.2

Graphical Displays and Associated Controls

Graphical displays are used in several of the SI400 application front panels to
plot two-dimensional data. For example, in the main front panel a graphical
display is used to present absorbance, transmission, reflectance or intensity
information as a function of wavelength. There are several types of controls
used to facilitate panning, zooming, and positioning of cursors that are common
to all of the graphical displays in the SI400 application.
All controls specific to the graphical displays are positioned immediately above
the display (Figure 6-3 Graphical Display).

Figure 7-3 Graphical Display
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Located just above the graph on the left side are indicators for the X and Y
position (Figure 6-4 Cursor Display) for Cursor 1 (blue cursor) and Cursor 2 (red
cursor).

Figure 6-4 Cursor Display
There is also a small square indicator that changes from white to black to
indicate which cursor is currently enabled. An icon consisting of the cursor
intersection within a small white box is a control that allows changing various
cursor display attributes such as a cursor or no cursor. Clicking on this will bring
up a menu of selections. An icon that appears as a padlock to the right of the
attribute control is a control that forces the cursor to be constrained to the
displayed data points, or free to move anywhere on the display.
Continuing to the right are two indicators labeled ΔX and ΔY that display the
distance between the red and blue cursors.
Figure 6-5 Cursor
Difference Display

The last control associated with the cursors is a four point diamond shaped icon
(Figure 6-6 Cursor Single Step Movement). Pressing on the points of the
diamond moves the selected cursor by single increments.

Figure 7-6 Cursor
Single Step
Movement

To the right of the cursor indicators and controls
are a group of controls for panning, zooming, and
auto-scaling (Figure 6-7).
The two controls
furthest left consist of buttons labeled X and Y,
and an associated red colored slide switch. The
buttons will cause the display to be immediately
20

Figure 7-7 Graph Control
panel

scaled to the data being displayed when pressed. The red colored slide
switches, turn auto-scaling on or off for X and Y dimensions. If auto-scaling is
turned on, the display scale will be adjusted to the data whenever the display is
updated (such as when a new spectrum is acquired). When auto-scaling is
turned off, the display scale will remain constant during data acquisitions. Two
controls to the right of the scaling controls labeled X.XX and Y.YY allow the
selection of the format and precision of the numbers displayed on the axis from a
menu.
The next three controls, or tools, to the right of the scaling controls are used for
pan, zoom, and cursor movement. The first of these tools has an icon that looks
like a magnifying glass. Pressing this control
brings up a menu of 5 different zoom modes,
and a "undo zoom" selection (Figure 6-8
Graph Zoom Controls).
Positioning the
mouse pointer over the desired zoom mode
and releasing the mouse button makes the
zoom selections. Once the selection is made,
positioning the mouse cursor in the area of the
Figure 6-8 Graph
display to be zoomed, and pressing the mouse
Zoom Controls
button performs zooming.
The zoom mode
selections include zoom to a selected X axis window, Y axis window, X and Y
axis window, and zoom in or out around a central point. The pan tool looks like a
hand, and when it is selected, the mouse cursor also appears as a hand in the
graphical display region. Press the mouse button and the hand will "grab" the
display. While holding the mouse button down, the display can be moved to pan
to any desired region.
Zooming can also be accomplished by directly editing the max/min labels on the
axis of the graph. Clicking on the max or min label on either axis and editing it to
the desired value does this. The tic marks will automatically be adjusted.
The cursor positioning tool that looks like a cross and when it is selected the
mouse cursor also appear as a cross within the graphical display region. The
cursors can be moved with the mouse by dragging them (press and hold down
the mouse button while the mouse is over the cursor to select and move the red
or blue cursor in the display). The coordinates of the cursor are displayed in the
indicators in the top left of the graphical display as discussed previously.
The last control associated with the graphical display is the "hide grid/display
grid" control that is accessed from the View pull down menu. Selecting the Grid
item will either hide or display grid lines on both the graphical display and hard
copy output depending on if the item is checked or not. If Auto-Scale is on when
the grid state is changed, the display will re-scale.
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7.3

On-Line Help

An on-line help feature is available to explain the purpose and functions of the
various controls and indicators on all front panels except the previously described
controls associated with the graphical displays. A help window is opened by
selecting "show help" item from the Help item on the menu bar or with the key
combination Ctrl + H. The help window will contain a description of the control or
indicator that the mouse cursor is currently over. To view a description of a
control or indicator, simply position the mouse cursor over the item of interest.

7.4

Function Keys

Using keyboard function keys in addition to the mouse point and click method
can perform some operations.
The function key assignments for these
operations are noted both in this manual under the description of the operation
and in the on-line help descriptions.

7.5

Setting Baud Rate and COM Port for the Host Computer

With a basic understanding of the software, the next
step is for the computer to communicate with the
spectrophotometer. When running for the first time
after installation, the COM port and its baud rate on
the host computer is set using the SI400 application.
Start the application as described in Section 7.1, and
select the Configure item in the Operate menu
(Figure 6-9 Operate pull down menu) to make the
Configure dialog box appear
(Figure 6-10
Configure Dialog). In this box are controls labeled
Serial Port and Baud Rate, Serial Port Type, and
Figure 7-9 Operate
buttons labeled Save and Close and printer type
pull down menu
section (there are also two additional buttons for
adjusting the lamp intensities that are disabled until
the spectrometer has been initialized and are described later). To change the
serial port selection, point to the Serial Port control and press and hold the left
mouse button. A group of options labeled COM1 through COM4 will appear.
While continuing to hold down the mouse button, slide the mouse up or down
until the desired selection is highlighted. Release the mouse button to make the
change take effect.
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Figure 7-10 Configure Dialog
Note that the selection of a non-existent or unusable COM port is possible at this
time. If this occurs, an error message will not be generated until the first attempt
is made to communicate with the spectrophotometer during initialization.
A new baud rate is selected in the same manner as the COM port selection.
After the COM port and baud rate selections have been made, press either the
Save button to make the changes permanent, or the Cancel button to nullify all
changes. When the Save button is pushed, the configuration changes are saved
to a disk or hard drive. This file is read by the SI400 application when it is
started, thus the configuration changes will be in effect any time the application is
used in the future until it is intentionally changed again.

7.6

Initializing the Spectrophotometer

Once the communications parameters have been set up, we are ready to
initialize the instrument. Spectrometer initialization involves communicating with
the spectrometer to determine its status, then sending the initialization file. This
must be performed every time power is cycled to the instrument. The
communications link is used for the first time during initialization, thus if any
communications problems are present they will become evident at this point. The
initialization process is started by selecting the Initialize item located in the
Operate menu (Figure 6-9 Operate pull down menu). If the communications link
has been established, the file transfer will occur (taking ~2 seconds), and the
spectrometer will be ready for use. Evidence of successful completion of
initialization can be seen on the main screen. The button in the upper right
corner labeled Blank will change from a nearly invisible light gray to a normal
dark gray color. The tungsten lamp shutter in the spectrophotometer will also
click as it opens and closes which may be used as an audible indication of
successful initialization. If the wavelength range requires the UV lamp, a dialog
box will appear asking if the user wants to start the UV lamp at this time. If the
Initialization is not successful, see the Troubleshooting Section 16.1
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8.

Instrumental Procedures

This section will provide some basic instrumental procedures for acquiring
absorption spectra in the main VI panel and the use of fiber optic accessories.

8.1

Fiber Optic Dip Probe

The standard fiber optic dip probe supplied with the 400 Series instruments
consists of two (model 410/430 probe) or three (model 420/440 probe) fibers that
converge at a point at the probe tip. Light from the lamps travels through the
solution to a concave second-surface mirror, and is reflected back into a fiber
that conducts the light to the spectrograph. The path length in solution is
approximately 1 cm. The dip probe body is fabricated from type 316 chemically
resistant stainless steel. The fiber optics and mirror are fused silica. A
chemically resistant epoxy is used to attach the various components to the probe
body. The protective sheath for the fiber optics is a steel monocoil clad with a
PVC coating.
The probe should be immersed only for short periods of time (~10 sec.) in:
1) strong acids and bases
2) concentrated weak organic acids (such as concentrated acetic acid)
3) halogenated organic solvents
Rinse the probe well when it is removed from the above solvents.

8.2

Using the Standard Dip Probe

The probe should now be ready to use. The lamp intensities were adjusted at
the factory but it may be necessary to adjust the tungsten and deuterium lamp
intensities before the system is fully operational. If an error message appears
when a blank is acquired indicating that the light source intensity is too high or
too low, refer to Section 14.1.
The optical design of the standard dip probe dictates that it be used with
solutions of very similar refractive index. The blank solvent should therefore
match the solvent used for the standards and unknown solutions. It is not
possible to use air as a blank.
When the probe is first immersed into a solution, a small bubble may form on the
conical fiber tip. Briefly stir the solution with the probe to dislodge any bubbles.
When the probe is extracted from a solution, a small drop of solution will remain
on the mirror. This can be easily removed by tapping the side of the probe gently
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on a bed of absorbent paper (such as Kimberly-Clark Teri or Kimtowels) placed
on the counter top. The probe should be rinsed between samples in the blank
solvent, and any wash solution also removed by tapping the probe.

8.3

Acquiring Absorption Spectra

After the instrument has warmed up (for best results, use one hour warm-up
period), place the dip probe into the blank sample and press the Blank button. A
brief shutter click-click will be heard as a short exposure is taken to determine the
optimum exposure time. After this there will be a delay while a “dark” spectrum is
taken without opening the shutter. This will be followed by a longer click----click
of the shutter while the blank spectrum is taken. This dark spectrum is
automatically subtracted from the blank and sample spectra. If both UV and
visible regions are being used, this procedure will automatically be performed
with the deuterium lamp as well.
After the blank has been taken, the Sample button will be enabled. Clean the
probe as described above and place it in the sample to be measured. Press the
Sample button to acquire the spectrum that will be displayed in the graph on the
Main front panel. When a new spectrum is taken, the Sample button and the file
name text box turns red indicating that the current spectrum is not saved. Once
the spectrum has been saved the Sample and file name text will return to gray.
Information about the spectrum can be entered into the File Information controls
in the lower left portion of the VI panel. This information is saved with the
spectrum. When the Save item is selected from the File Menu, a dialog allows
the file name to be edited and a path to be selected for saving the data.
For more details about the operation of Main VI functions, see Section 9.

8.4

Cuvette Cell Holder

For measuring spectra of solutions using standard 1 cm pathlength cuvette cells
or round ½” tubes, a cell holder accessory is available. The cuvette with the
blank solution is placed into the cell holder and a blank is taken followed by a
sample solution. If disposable cuvettes are being used, it is important to be
aware of a mark that is normally at the top of the cuvette. This mark indicates
the direction that the light should pass through the cuvette and for best results,
the cuvette should be places so that the mark is always facing in the same
direction. Some quartz cuvettes also have direction indicators.

8.5

Fiber Optic Reflectance Probe

The reflectance probe is used to obtain the spectra of solid samples that are
opaque. There is a collar on the tip of the probe that is used to set the distance
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of the fiber optics from the sample. This is necessary so that the reflected light
can enter the collection fiber. A blank should be taken using a white surface that
is similar in texture to the sample. The user should be aware that some white
papers have a UV dye in them that will absorb UV light and emit in the blue
spectral region. This type of paper can cause problems when used as a blank.
A piece of PTFE Teflon provides a good diffuse reflector for use as a blank when
doing reflectance measurements.

8.6

External Shutter and Lamp Connectors

The SI430/440 spectrometer has connectors for both an external shutter and an
external lamp. These connectors enable the use of optional accessories adding
more flexibility to the instrument. If an external shutter was not included with
your instrument and is needed, call S.I. Photonics and one can be provided.
Note that the outputs on these connectors are designed to work with S.I.
Photonics accessories. Please consult S.I. Photonics technical support before
connecting any other devices to these connectors.

External shutter power connector
Fiber coupler (pre-attached)

Collection fiber

Spectrograph input
External shutter assembly

Fiber coupler
setscrews

Figure 8-1 Setup of external shutter
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8.6.1.1

External Shutter Connector

The external shutter connector is positioned to the right of the tungsten lamp
output (see Figure 7-1 Setup of external shutter) and is the smaller of the two
external connectors. The external shutter is used with an external lamp,
radiometry measurements, and with integrating spheres.

8.6.2

External Lamp Connector

The external lamp connector is to the right of the shutter connector. When this
connector is used, the internal lamp is disabled and a constant current is
supplied at the connector. The external lamp connector is used with the
integrating sphere accessory.

8.7

Integrating Sphere Accessory

The integrating sphere is used to provide diffuse illumination of samples that are
difficult to illuminate properly with the reflectance probe.

8.7.1 Attaching Integrating Sphere
A lamp is mounted on one of the sphere ports at 90 to the sample port and there
is a baffle to block direct illumination of the sample. The Power connector
coming from the sphere for the lamp plugs in at “External Lamp”. The collection
fiber is mounted opposite the sample port. The port for the fiber will have a plug
in the hole during shipping. Remove this plug by loosing the setscrew in the side
of the port. Insert the fiber optic cable and tighten the setscrew. The collection
fiber must be mounted to the external shutter, which is mounted to the
spectrophotometer as described above. The sphere is mounted on a post above
the sample area. A blank must be taken as in the reflectance measurement
discussed above, followed by the sample measurement.

8.7.2 Integrating Sphere Operation
The sphere has 4 ports; lamp, fiber, reference and sample. The smaller ½” port is
for the lamp. The port opposite the lamp can be used as a reference port to
improve sampling accuracy. The sample port is 90 from the lamp port and has a
baffle to prevent the light from the lamp directly illuminating the sample. The fiber
port is 180 from the sample port.
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Reference port: A small amount of the light reflecting off of the object placed in
front of the sample port will reflect back into the sphere, bounce around and then
eventually strike the sample again. Since this light has already been filtered by
the sample it is no longer white light and can cause a minor effect on the
measurement if the sample is very dark. To eliminate this effect the blank
measurement is taken with the sample or similarly colored object in the reference
port. The white reflectance standard in the sample area is then switched to the
reference port during sample measurements. The user should determine if this
minor effect has a relevant impact on their measurement accuracy.
Lamp port: The sphere has an internal tungsten lamp similar to the one in the
instrument. The lamp has a lower color temperature and longer life than the
standard lamp used in the instrument. The Spectral part number for this lamp is
1662. The lamp will be very hot, wait for it to cool before replacing. Unplug
power to the lamp before replacing. To change the lamp, loosen the two tiny
setscrews holding the lamp housing onto the sphere. Unplug the lamp and
replace it. Do not touch the lamp with your fingers. The oils from your fingers will
damage the lamp. If the lamp is touched clean with alcohol before using.
Fiber port: The fiber port is where the light is collected and transferred to the
spectrometer. For large objects longer fiber optic cables can be used to increase
the distance of the integrating from the instrument.
Sample port: The fiber numerical aperture and the spectrometer optics limit the
sample area to about a 3/4 inch diameter at a 4 inch distance. Smaller spot sizes
can be achieve with the use of the port reducers. The sample should be placed
as close to the sample port opening as possible. The sample should also be
placed at the same distance each time. The sphere is shipped with a generalpurpose stand but most samples are best measured with custom holders to
position specific samples or to place the sphere on a flat object.
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9.

The SI400 Main Front Panel

The main front panel controls are used for configuring and initializing the
instrument, general data acquisition, examining spectra, and saving spectra. It is
also used to gain access to other specialized panels such as the quantitative
analysis, timed spectral acquisition, peak find and multiple spectra display front
panels.

Figure 9-1 Main front panel

9.1

Graphical Display

The graphical display on the main front panel is used to present absorbance,
transmission, reflectance, sample or blank intensity as a function of wavelength.
The controls use to manipulate the display are discussed in Section 7. The type
of data presented on the graphical display can be changed using a control
located near the upper right corner of the graph. Options are:
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Abs - Calculates and displays absorbance of sample referenced to blank.
% T - Calculates and displays % transmission of sample referenced to blank.
% R - Calculates and displays % reflectance of sample referenced to blank.
Intensity - Displays raw light intensity of sample in arbitrary units.
Blank - Displays raw light intensity of the blank in arbitrary units.
The current display mode is always indicated on the control.

a. Main Front Panel Controls
The following is an alphabetical listing of the Main front panel controls.
Blank - Acquires and stores spectrum of blank sample for calculation of
absorbance and % transmission relative to Sample spectrum. Data is
stored until the wavelength range is changed or a new blank is acquired.
Function key F2
Blue Cursor - Adds an entry into the wavelength column of the data table at the
current position of the blue cursor.
Function Key F9 (records blue cursor position and updates table)
Clear Table - Clears the data table.
Configure – Option of the Operate pull down menu, used to set the COM port
and baud rate for communication with the spectrophotometer and to
access the lamp adjustment screens.
Export Files – From the File menu exports a single file or a group of files that
have been saved on the disk to an Excel or delimited ASCII text
spreadsheet file. Select the Export function from the Files menu and a
window will open (Figure 9-2 Directory Selection) asking the user to select
the directory or folder containing data files to be exported
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Figure 9-2 Directory Selection
In the new window click on Select New Folder, to open another window directory
and open the folder where the saved files are located. Highlight the folder and
click on Select Cur Dir. (Do Not click on Open) See Figure 9-3 Selecting File
Folder.
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Figure 9-3 Selecting File Folder

The next screen (Figure 9-4 –
Selecting Individual Files) lists all
the spectrum in the selected
folder. The user can select one
spectrum to be exported or a
group up to 9 spectra. To choose
more than one file, use the shift
key for multiple selections. For
spectrum in a contiguous series of
file names Shift-Click and drag the
mouse. Click OK.

Figure 9-4 Selecting
Individual Files.
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Another window opens and
list the selected files and
allows the user to choose the
type of data to export, the
type of file format, and
whether to smooth the data.

Figure 9-5 Selecting File Format

Figure 9-5 Selecting File Format

The last panel in the export function pops up. This window saves the files in the
new format in the location the user has selected. The exported data must have
the same wavelength range since the first column contains the wavelength
values and each successive column contains data for each selected file. Also at
this point the user can complete the export process by pressing the Save button,
or Cancel the operation. When the Save button is pressed, a dialog opens up
(figure 9-6 Select file name and path for exported data) that allows the user to
choose the path and file name for the exported data.
Function Key Ctrl+E

Figure 9-6 Choosing Files to Save.
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File Name Filter - limits the sort criteria when retrieving files from the disk.
Grid – From the View menu allows user to add or remove the grid lines in the
spectr Figure 9-6 Select file name and path for exported data a display.
Function Key Ctrl+G
Initialize – Found in the Operate menu, Initializes the spectrophotometer. This
function needs to be performed only on start up or if power to the
spectrophotometer has been turned off.
Lock Blank - This button will disable the Blank button until the lock is released
by is pushing this button again. This prevents accidental acquisition of a
new blank.
Open - Opens a data file created with the Save item in the File menu. The
spectrum in the data file, along with all other file information, is displayed.
Function Key F6 or Ctrl+O
Multiple Spectra – from the View menu opens a new front panel to view up to
10 spectrum at once. Refer to section 13, the Multi Spectrum Display
instructions for command summary on this panel. Push the Close button
to return to the Main front panel.
Auto Add to Multiple Spectra – automatically places the newly acquired
spectra into Multi Spectrum Display panel. The default is On.
Function Key Ctrl+M
Peak Find – Opens a new front panel for peak and valley analysis. Refer to the
Peak Find instructions in section 12 for command summary on this panel.
Push the Close button to return to the main front panel.
Function Key F4
Precision – Access through the Operate menu
Low - This mode is useful for fast measurements in the 0.05 to 2.00
absorbance range. The array detector is read 2 times and
averaged.
Normal - This mode is adequate for most measurements in the 0.05 to
2.00 absorbance range. The array detector is read 20 times and
averaged.
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High - Increases precision of measurements by averaging 100 reads of
the array detector. Use only when the highest precision is
necessary. This mode increases the time to acquire both sample
and blank by approximately a factor of 5 compared to Normal
mode.
Print Graph & Info - Outputs spectrum, comments section and data table
displayed on the panel to the selected Windows output device.
Function Key Ctrl+P
Print Only Graph - Outputs spectrum only
Quantitative –Accessed through the Operate menu, opens a new front panel for
quantitative analysis. Refer to the quantitative analysis instructions for
command summary on this panel in section 10. Push the Close button to
return to the main front panel.
Function Key Ctrl+Q
Red Cursor - Adds an entry into the wavelength column of the data table at the
current position of the red cursor.
Function Key F10 (records red cursor position and updates table)
Reference Spectrum – Allows for two spectra to be viewed and one is
designated as a reference. There are two controls to turn on or off
displaying the reference spectrum, and one to turn a displayed
spectrum into the reference spectrum.
Set - Changes currently displayed (black colored) spectrum into the
reference (red colored) spectrum.
Function Key F11
On/Off - turns on and off (depending on current state) the display of the
reference spectrum and activates the Set button. This button also
controls whether or not the reference spectrum is printed on hard
copy.
Function Key F12
Restore Full View - – Displays original spectrum to full scale
Function Key F3 or Ctrl + F
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Sample - Acquires a spectrum of a sample. Performs a calculation for the
display mode selected. A blank must be acquired before the Sample
button becomes active.
Function Key F1
Save - Saves the displayed spectra, comments and data table shown on screen
to disk. Data is retrieved with the Open item. The file formats default is
compatible with the SI400 application only.
Function Key F7 or Ctrl+S
Save As – Saves the spectrum in different format then the *.SIS default. These
files can not be open in the SI 400 application once saved in the file
formats below.
Text - Save spectrum data into comma delimitated text file.
Excel – Saves spectrum into Microsoft Excel format.
Auto Save – Automatically saves the spectrum to a chosen file after sample is
taken. The default is off. To switch on, click Auto Save On. A new window
will open to select path (Figure 9-7).
Auto Save As – Automatically saves sample spectrum as the default *.SIS
format or can be selected to save as *.text file. Select by checking the
chosen option.
Save Setup - Saves the current settings of the program to be recalled when the
spectrometer is initialized. The settings saved include the wavelength
range, lamp crossover wavelength, the table of wavelengths to be
monitored, current disk paths for data, precision setting, smoothing on/off
and points, and the grid on/off.
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Figure 9-7 Auto Save Path settings

Smoothing - Smoothes the data that is displayed and that used for quantitative
data analysis by a Savitzky-Golay quadratic-cubic algorithm with an
adjustable number of points. This effectively increases the signal to noise
ratio of spectral data at the expense of reduced spectral resolution. Data
saved to disk files is not saved in smoothed form, but any file read from
disk can be smoothed. The smoothing algorithm is described in J. Anal.
Chem., 1964, 36, p. 1627.
On/Off - turns smoothing on or off. Only the currently displayed spectrum
is affected. Once smoothing has been turned on any subsequently
acquired spectra, or data files read from disk will be automatically
smoothed.
Points - varies the number of points in the smoothing algorithm. As the
number of points is changed, the current spectrum displayed is
dynamically updated with the new smoothing parameters.
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Stop - Used to clear errors, also halt operation of the program. This item is
located in the Operate menu. Restart by clicking on the arrow in title bar.
Function Key Ctrl+.
Timed Acquisition – Accessed through the Operate menu opens a new front
panel for repetitive timed spectral acquisition. Refer to section 11 the
timed acquisition section for command summary on this panel. Push the
Close button to return to the main front panel.
Function Key Ctrl+T
Update Table - Updates the absorbance, % transmission, % reflectance or
intensity fields in the data table. Used when wavelengths are manually
entered in the data table rather than using the blue cursor/red cursor
buttons.
UV Lamp (model 420 & 440 only)
On/Off - Turns on or off the deuterium lamp. The lamp power supply
requires approximately 20 seconds to start the lamp discharge.
The lamp should be allowed to warm up for at least 20 minutes and
preferably 1 hour to reach maximum stability. Baseline drift will be
observed if the lamp has not had time to stabilize.
Wavelength Range - From the Operate
menu opens a dialog box which
allows the operator to change the
wavelength range of the spectrum
that will be acquired and the lamp
crossover wavelength. Limiting
the range to wavelengths of
interest will speed up data
transfer and reduces the size of Figure 9-5 Wavelength range Window
saved files.
The minimum
wavelength is 190 nm for Model
440 and 350 nm for Model 430. The maximum wavelength is 980 nm for
both models. The lamp crossover wavelength (Model 420 & 440 only) is
the wavelength where the change from the deuterium to tungsten lamp is
made. The default in the initial setup is 460 nm. This gives the best
overall performance. The lamp crossover can be set from 350-800 nm.
When it is set to >460 nm, sharp and intense structure in the deuterium
spectrum near 485, 580, and 656 nm can cause errors in the acquired
spectrum near those wavelengths. Also, due to the effect of the intensity
scaling caused by these features, the overall precision can be adversely
affected.
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Key Function Ctrl + W
NOTE: A new blank must be acquired every time the range is
changed. Once the desired wavelength range is selected, save
the parameters by going to the File menu and clicking on Save
Setup
Y Scale – adjusts the y-axis to fit the spectrum to fill the full display.
Function Key F5
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10. The SI400 Quantitative Front Panel
The Quantitative front panel is used to acquire and analyze data for quantitative
analysis of samples. Before opening the Quantitative front panel, it is best to
take a blank spectrum and a sample spectrum (see Section 8.3) of a standard
solution to facilitate the choosing of analysis wavelengths. It is opened by
selecting the Quantitative option under the Operate menu in the Main front
panel. Controls are available to acquire data from standards and unknowns, fit
standards data to a curve, and determine concentrations of unknowns based on
the standards data. The Quantitative front panel has a graphical display for
analytical data and a working curve, a section for controls and data related to
analytical standards and a section for controls and data related to unknowns.

Figure 10-1 Quantitative front panel

10.1 Quantitative Analysis Front Panel
The standard number and concentrations for each standard are entered in the
Standards Table.
The absorbance for the standards at the analytical
wavelengths and the confirmation wavelengths will automatically be entered into
the rest of the table when the Acquire Standard button is pressed.
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Description for the unknowns is entered in the Unknowns table. Concentration
and absorbance results will be calculated and inserted when the Acquire
Unknown button is pressed.

10.2 Graphical Display
The graphical display on the Quantitative front panel is used to present
absorbance as a function of concentration information. The controls use to
manipulate the display are discussed in Section 7.2. Data from the analytical
wavelength, or confirmation wavelengths can be selected using a control located
near the lower left corner of the display.

10.3 Quantitative Analysis Procedures
Once the Quantitative window is open, the procedure for doing an analysis is as
follows:
1. Press Selected Wavelengths button to open the Quantitative Wavelengths
Selection from the Operate menu ( Figure 10-2) that will allow the selection
of the wavelengths to be used for the analysis.

Figure 10-2 Quantitative Wavelengths Selection panel
44

The analytical wavelength is usually the wavelength of maximum absorbance
for the sample. The reference wavelength is usually a point of minimum
absorbance for the sample. When a reference wavelength is selected, the
absorbance at this wavelength is subtracted from the absorbance at the
analytical wavelength during the computations in the Quantitative front panel.
The confirmation wavelengths are typically used for tests of purity or chemical
interference in a sample. The wavelength is usually chosen in a region of
appreciable absorbance, but removed from the analytical wavelength.
The selection of analytical, reference, and confirmation wavelengths may be
made by typing in the value into the appropriate box. An alternate method is
to position a cursor at the desired location on the spectrum in the graphical
display. Select Analytical, Reference, Confirmation 1, or Confirmation 2 on
the Wavelength Selection control and press the Blue Cursor or Red
Cursor button depending on which cursor is being used. The wavelength of
the cursor is entered into the selected item. A spectrum of an analytical
standard must be acquired in the Main front panel to use the graphical input
approach.
Each type of wavelength must be turned ON in order to be incorporated into
the quantitative calculations.
2. There is an option to take a new Blank spectrum if it is deemed necessary.
Press the Unlock Blank button to make the Blank button active and proceed
with taking a new blank as described in Section 8.3. After the blank is taken,
the Blank button is automatically locked to lessen the chance of it
inadvertently being pressed.
3. Enter the concentrations of the standards into the Standards table. If there
are more than ten standards, a scroll bar will appear on the right side of the
table to allow the table to be scrolled down.
4. Next, acquire the spectra for the standards. When the Acquire button for
standards is pressed, the data will be put into the table for the standard
number indicated in the Standard Number control. This control defaults to 1
and will automatically increment to the next standard number. This control
can also be used to manually set the next standard number to be acquired.
5. When all the standards have been acquired, select the Calibrate item in the
Operate menu and the calibration curve (linear least squares fit) for the data
will be calculated and displayed on the graphical display. At this point, the fit
results can be viewed by pressing the View Fit Results option in the Operate
menu.
6. Now we are ready to measure the unknown samples. Prepare the first
unknown sample to be measured. A description can be typed into the
unknown table in the Name column. The Unknown Number control selects
45

the unknown number in the Unknowns table for which data will be collected.
This control is initially set to 1 and will automatically set to increment to the
next number after a new spectrum is acquired. Data is acquired by pressing
the unknown Acquire button and the results will appear in the Unknowns
table. There are scrollbars on this table for both vertical and horizontal
movement. The horizontal scrollbar allows viewing of the results for the
Confirmation wavelengths.
Further details of the on the Quantitative front panel are given below.

10.4 Quantitative Front Panel Controls
Acquire - Two Acquire buttons are present, one in the standards section and the
other in the unknowns section. These buttons acquire a spectrum for the
data tables they are adjacent to. The standard and unknown numbers are
chosen before the acquisition, then data is stored in the
corresponding line in the table. For the standards Acquire button,
the known concentration must be entered before taking the spectrum.
NOTE: Analytical, reference and confirmation wavelengths must
be set before the button is active. See Wavelength Selection.
Function Key Acquire Standards F1
Function Key Acquire Unknowns F6
Blank - Acquires and stores spectrum of blank sample for calculation of
absorbance and % transmission relative to Sample spectrum. Data is
stored until the wavelength range is changed or a new blank is acquired.
Calibrate – Found in the Operate menu calculates the best fit function to
standards data using linear regression.
Clear Standards - Clears all information entered into the standards table and
accessed from the Operate menu.
Clear Unknowns - Clears all information entered into the unknowns table and
accessed from the Operate menu.
Close - Closes the Quantitative front panel and opens the Main front panel. Data
in the Quantitative front panel will not be lost.
Concentration units
Molarity - data units displayed as molarity (mol/L).
PPM - data units displayed as parts per million.
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File Name Filter - Limits sort criteria when retrieving files.
Fit Results - Displays statistical data from linear regression for Analytical and
Confirmation wavelengths and is found in the Operate menu.
Format - Sets the display preferences for concentration values . The units may
be decimal, scientific or engineering. Number of decimal places displayed
is also set here.
Function Key F11
Open - Retrieves a data file saved with the Save command from disk found in
the File menu.
Print Graph - Outputs data in graph, comments section, standards table, and
unknowns table displayed on the screen to selected output device. This
selection is accessed in the File menu.
Function Key Ctrl+P
Save - Saves the displayed data and comments shown on screen to disk and
accessed in the file menu. Data is retrieved with the Open item. The file
format is compatible with the SI400 application.
Function Key Ctrl+S
Save as Text - Saves data as an ASCII tab delineated file for export to
spreadsheets and data manipulation programs. Save as Text is accessed
from the File Menu.
Save as Excel – Saves data as an Excel spreadsheet file for export later to
perform data manipulations and accessed from the File menu.
Select Wavelengths – In the Operate menu opens a new front panel that
displays a graph of a spectrum for the selection of analytical, reference
and confirmation wavelengths for the quantitative analysis front panel.
Refer to the Wavelengths front panel section 10.5 for a summary of the
controls on this screen
Spectrum – Found under the View menu displays a spectrum at full screen size
of the most recent spectra acquired.
Standard number - Changes the line number where data is inserted in the
standards table when Acquire button is pressed. This number will
automatically increment by one after each sample.
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Unk. Conf. - Used to set the acceptable percent difference between analytical
and confirmation concentration. A warning will be displayed if unknown
concentration is out of tolerance.
Unlock Blank - This button will enable/disable the Blank button. This prevents
accidental acquisition of a new blank.
Unknown number - Changes the line number where data is inserted in the
Unknowns table when Acquire button is pressed. This number will
automatically increment by one after each sample.

10.5 Quantitative Wavelengths Front Panel Controls
The following is an alphabetical listing of the Quantitative Wavelengths Front
Panel controls (Figure 10.2 Quantitative Wavelength Selection panel).
Analytical Wavelength - Is a control where the analytical wavelength can be
directly entered from the keyboard. There is also an on/off control to
enable or disable the use of the analytical wavelength in the quantitative
front panel.
Blue Cursor - Enters the wavelength into the selected control box (see
Wavelength selection) at current position of the blue cursor.
Close - Closes the Analytical Wavelengths window and brings back the
Quantitative screen.
Confirmation Wavelength 1 and Confirmation Wavelength 2 - Are controls
where the confirmation wavelengths can be directly entered from the
keyboard. There is also an on/off control to enable or disable the use of
confirmation wavelengths in the quantitative front panel.
Red Cursor - Enters the wavelength into the selected control box (see
Wavelength selection) at current position of the red cursor.
Reference Wavelength - Is a control where the reference wavelength can be
directly entered from the keyboard. There is also an on/off control to
enable or disable the use of a reference wavelength in the quantitative
front panel.
Wavelength Selection - Determines which wavelength type will be recorded
when the Red Cursor or Blue Cursor button is pushed. Selections are:
Analytical
Reference
Confirmation 1
Confirmation 2
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11.

The SI400 Timed Acquisition Front Panel

The timed acquisition front panel is accessed by going through the Operate
menu of the Main front panel and is used to acquire spectral information at fixed
time intervals. The wavelength range over which spectra will be acquired must
have been previously set using the wavelength range item on the Main front
panel’s Operate menu.. The panel that opens has a graphical display similar to
the one on the Main front panel. An acquisition mode selector allows the
selection of full spectrum acquisition, or discreet wavelengths. There are some
changes in the front panel depending on the mode selected.

Figure 11-1 Timed Acquisition, Full Spectrum Mode
In full spectrum mode (see Figure 11-1), the spectra are automatically saved
either as text files or in SI400 format as the user selects. The naming and path
for saving the spectra is specified in the acquisition setup covered below.
Opening and printing a spectrum taken with timed acquisition is performed in the
Main front panel.
In discreet wavelength mode (see Figure 11-2), a table appears displaying the
wavelengths to be monitored, along with a color assignment for that wavelength
as it is plotted on the graphical display. Data acquired at discreet wavelengths
can be viewed graphically as changes in absorbance or transmission as a
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function of time. As many as ten discreet wavelengths can be simultaneously
monitored.
An assortment of controls for saving, opening, and printing data files similar to
that found in the discussion of the Main front panel appear on this Timed
Acquisition front panel. Files from data acquired in the discreet wavelength
mode are incompatible with those acquired using the full spectrum mode, and
can only be viewed from the Timed Acquisition front panel. There is an
additional command on the discrete wavelengths mode panel for kinetics that is
described below.

Figure 11-2 Time Acquisition, discrete Wavelengths Mode

11.1 Timed Acquisition Front Panel Controls
The following is an alphabetical listing of the Timed Acquisition front panel
controls.
Close - Closes the timed acquisition front panel and re-opens the Main front
panel.
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File Name Filter - Limits sort criteria when retrieving files and is accessed from
the File menu..
Kinetics – From the Operate menu opens a Kinetics front panel (Figure 11-3
Kinetics front panel) that allows the viewing of discrete wavelength data as
a kinetic plot of raw data or a first order plot with rate constants for each
wavelength measured. There is also an option to limit the plot display and
rate calculations to the data that is between the two cursors.
Mode – Allows the selection of full spectrum or discreet wavelength acquisition
modes.
Open - Accessed from the File menu retrieves a data file from the disk that was
previously saved.

Figure 11-3 Kinetics front panel
Print - Outputs data in graph, comments section, and wavelengths displayed on
the screen to selected output device. The Print command is found in the
File menu.
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Samples Taken - This indicator shows the number of data acquisitions
completed. This number is updated as acquisitions are made.
Save – In the File menu, the Save item saves the displayed data and comments
shown on screen to disk. Data is retrieved with the Open command. The
file format is compatible with the SI400 application only.
Save as Text – From the File menu saves data as an ASCII tab delineated file
for export to spreadsheets and data manipulation programs.
Save as Excel – From the File menu saves data as an Excel spreadsheet file for
export later to perform data manipulations
Setup - Opens a dialog box (see Figure 11-4) where a number of setup
parameters are selected. The dialog box changes depending upon which mode
(full spectrum or discreet wavelength) is chosen. In full spectrum mode, the
dialog box allows selection of the time interval between acquisitions, number of
acquisitions, and the file information, and specific wavelengths of interest. The
full wavelength spectrum is saved and if any wavelengths are entered into the
Wavelength table, these wavelengths are also saved with the spectrum. When
the spectrum is opened in the main front panel, the values at those wavelengths
will be displayed in the Wavelength table on the Main front panel.

Figure 11-4 Timed Acquisition Setup Full Spectrum Mode
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Multiple spectrum files are saved using a data series name, followed by an
incremented number, followed by the .SIS extension. Example: Data Series
####.SIS The data series name is entered in the Data Series control (See TEST
in Figure 11-4) The Start at # control selects the beginning number in the series.
The Select Folder button opens a dialog box (Figure 11.5) to choose the folder
where the spectra will be saved. Once a folder is selected, click on Select Cur
Dir button to return back to the set-up box.

Figure 11-5 Set path dialog box

In the discreet wavelength mode, the parameters to be chosen are the time interval
between acquisitions, number of acquisitions, and the wavelengths to be acquired.
Up to ten wavelengths can be chosen. Any wavelength set to zero will be
ignored.
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Figure 11-6 Timed Acquisition Setup Discrete Wavelengths Mode
In this mode, only the values at the chosen wavelengths are saved. If the Saving
Mode is set to Manual, no Select Folder button is present, as the data for the
discrete wavelength acquisition will be saved manually at the end of the run with
the Save to File button in the Timed Acquisition panel. When set to Continuous
as in Figure 11-6, the Select Folder button is present and the file path is set in a
dialog box seen in Figure 11-5. In this mode, the data is saved to the same file
after each spectrum is taken. This is useful when doing long time acquisition so
the data is not lost if there is a computer problem or power failure. Files saved as
discrete can only be opened in the Time Acquisition window
Start - Pressing this button starts acquisition for either full spectrum or discreet
wavelength mode.
Time Remaining - This is an indicator that shows the amount of time remaining
to complete the data acquisition.
Time Until Next Acq. - This indicator displays the time remaining until the next
acquisition will take place.
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12. The SI400 Peak Find Front Panel
The Peak Find front panel is opened by pressing the button on the Main front
panel and is used to analyze the peaks and valleys of a spectrum. These values
are also displayed in a table. A spectrum must have been taken or opened in the
Main front panel before analysis in the Peak Find window.

Figure 12-1 Peak Find front panel
12.1 Graphical Display
The graphical display on the Peak Find front panel is used to present
absorbance, transmission, reflectance or sample or blank intensity as a function
of wavelength. The controls to manipulate the display are discussed in section
7.2.
When the window is opened, the default representation will show the peaks of
the spectrum. To view the valleys of the spectrum, select the box in the lower
right corner, and choose the valley option.
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1.2 Peak Find Front Panel Controls
The following is an alphabetical listing of Peak Find front panel controls.
Close – Closes the Peak Find front panel and re-opens the Main front panel
Film Thickness – Calculates the thickness of substrate in micrometers (um).
The user must type in the refractive index of film being tested. This
calculation is found under the peaks find table in the “No Calculation”
menu.
Find Peaks – Calculates the highest point in each peak, or lowest point in a
valley, marks the spectrum and updates table up to 60 points.
Function Key F5
Peak Width – Used in the calculation of determining the peaks.
Peaks / Valleys - Toggle switch to change the display of peaks to valleys.
Print – Prints spectrum and table.
Restore Full View – Displays original spectrum to full scale. This operation is
found in the View Menu.
Smoothing - Smoothing - Smoothes the data that is displayed by a SavitzkyGolay quadratic-cubic algorithm with an adjustable number of points. This
effectively increases the signal to noise ratio of spectral data at the
expense of reduced spectral resolution. Data saved to disk files is not
saved in smoothed form, but any file read from disk can be smoothed.
The smoothing algorithm is described in J. Anal. Chem., 1964, 36, p.
1627.
Points - Varies the number of points in the smoothing algorithm. As the
number of points is changed, the current spectrum displayed is
dynamically updated with the new smoothing parameters.
On/Off - Turns smoothing on or off. Only the currently displayed
spectrum is affected. Once smoothing has been turned on any
subsequently acquired spectra, or data files read from disk will be
automatically smoothed.
Thresh – The threshold cursor allows the manipulation of the peak find function
to only show the peaks above the thresh cursor level. In valley analysis,
only the troughs below the thresh cursor are displayed. The cursor
movement is performed the same as the other two cursors.
Y Scale – Adjusts the y-axis to fit the spectrum to fill the full display.
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13.

The SI 400 Multi Spectra Display

The Multi Spectra Display front panel is opened through the view menu on the
Main front panel and is used to see and manipulate up to 10 spectra at a time. To
be displayed in this window , the spectra must have been acquired in the Main
front panel or as saved disk files. The graphical display is similar to the one on
the Main front panel.

Figure 13-1 Muli Spectra Display front panel
The spectra can be manually opened in the Multi Spectra Display window from
saved files or they can be automatically transferred over by selecting the Auto
Add to Multiple Spectra option in the Main front panel. This feature is on by
default. As each spectrum is acquired and transferred to the Multi Spectra
Display panel, the spectrum shift down the list. When more than 9 spectrum are
opened or transferred, the spectrum are removed from the bottom. The tenth
spectrum in the table is a reference cell and will not automatically be removed.
The spectrum in the Multi Spectra Display front panel can be manipulated in
simple mathematic functions such as adding, subtracting and multiplying. The
arithmetic can be performed on the spectra with two spectra or a spectrum and a
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constant. The newly formed spectrum will transfer up to the number one
spectrum cell in the table.

13.1 Graphical Display
The graphical display on the Multi Spectra Display front panel is used to present
absorbance, transmission, reflectance or sample or blank intensity as a function
of wavelength. The controls to manipulate the display are discussed in section
7.2.
The spectra displayed can be turned on and off by selecting the on/off button
next to each spectrum.

13.2 Multi-Spectra Display
The following is an alphabetical listing of Multi Spectra Display controls
Blue Cursor - Adds an entry into the wavelength column of the data table at the
current position of the blue cursor.
Calculate – Performs the mathematical operation between the two selected
spectra or spectra and a constant value.
Clear Spectrum – Clears all or individual spectra from the spectra list.
Clear Table - Clears the data table.
Close – Closes the Multi Spectra Display panel and re-opens the Main front
panel.
Export Files - From the File menu exports a single file or a group of files that
have been saved on the disk to an Excel spreadsheet file or a delimited
ASCII text spreadsheet. For instructions, refer to section 9.2.
File Name Filter - limits the sort criteria when retrieving files from the disk.
Grid – From the View menu allows user to add or remove the grid lines in the
spectra display.
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Info – Opens a new window to edit and review File Name and Comment section

Figure 13-2 Spectra Info Box
ON/OFF – Adds or removes the spectra from the display window
Open File - Opens a data file created with the Save File menu item. The
spectrum in the data file, along with all other file information, is displayed.
Open Multiple Files -Opens multiple data files saved on disk. The spectrum in
the data file, along with all other file information, is displayed.
Select a Folder – Opens new window to selects a folder from which to
open files. Click on Select Cur Dir to finish operation and return to
Open Multiple Files window.
Select Files – Click on individual files or use the shift key for multiple
selections up to 9 spectra. To select a contiguous series of file
names, shift + click and drag. Click OK to finish.
Print Graph - Outputs spectrum only with legend
Restore Full View – Rescales the image to the original settings.
Save – Select the spectrum to be saved and edit comment section in the
comment window. Click on Close and a save file window opens. Type in
file name and click on Save.
Set Reference – Selects which spectra in the table is to be used as a reference
and transfers all data of the chosen spectra to the reference spectrum
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destination. To transfer a spectrum into the reference cell, the spectrum
must be turned ON to come up in selection choices.
Smoothing - Smoothes the data that is displayed and that used for quantitative
data analysis by a Savitzky-Golay quadratic-cubic algorithm with an
adjustable number of points. This effectively increases the signal to noise
ratio of spectral data at the expense of reduced spectral resolution. Data
saved to disk files is not saved in smoothed form, but any file read from
disk can be smoothed. The smoothing algorithm is described in J. Anal.
Chem., 1964, 36, p. 1627.
On/Off - Turns smoothing on or off. Only the currently displayed spectrum
is affected. Once smoothing has been turned on any subsequently
acquired spectra, or data files read from disk will be automatically
smoothed.
Points - Varies the number of points in the smoothing algorithm. As the
number of points is changed, the current spectrum displayed is
dynamically updated with the new smoothing parameters.

Update Table - Updates the absorbance, % transmission, % reflectance or
intensity fields in the data table. Used when wavelengths are manually
entered in the data table rather than using the blue cursor/red cursor
buttons.
View All – From the view menu, turns all spectra in the table to the ON position,
displaying all spectra.
Y Scale – Adjusts the y-axis to fit the spectrum to fill the full display
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14. Lamp Adjustments
The tungsten source used in the 400 series instruments is a 10 watt quartzhalogen lamp with approximately 3100oK filament temperature. Its average life
expectancy is over 200 hours (longer life, lower output lamps are available; call
S.I. Photonics for information). The deuterium source is a high-intensity, prealigned lamp with an average life of 4,000 hours. Both lamps need to be
periodically replaced as normal instrument maintenance. The tungsten source is
replaced only when it fails. The deuterium source is replace whenever the
estimated operating hours exceeds its lifetime, or when the lamp intensity and
stability are unacceptable.
Use care in replacing both tungsten and deuterium lamps as the lamp envelopes
are fragile and can break during handling. Also, both lamps and their lamp
housings become extremely hot during operation. Allow them to cool before
disassembling. Finally, the deuterium lamp outputs ultraviolet radiation that is
harmful to eyes and skin. Observe the precautions on the replacement lamp,
and protect the eyes with plastic safety glasses designed to absorb UV light if it
is necessary to view the lamp during operation.

14.1 Adjusting Lamp Intensities
Any time the tungsten or deuterium lamps are replaced or adjusted, or the fiber
optic probe is changed on the spectrophotometer, it may be necessary to adjust
the lamp intensities such that the minimum detector integration time is used, and
the CCD detector does not become overexposed. This is accomplished by lamp
intensity adjustment screws that prevent a portion of the light from the lamps
from reaching the fiber optic probe input.
During all lamp intensity tests and adjustments, the fiber optic probe used with
the spectrophotometer should be installed and sampling a "blank". If a solution
dip probe is used, it should be immersed in a blank solution. If a reflectance
probe is being used, it should be pointed towards a white reflectance standard.
The reflectance probe rarely needs the light reduced.
To adjust the lamp intensity, the AC power must be disconnected and the
spectrophotometer cover must be removed (see Section 5.2 Removing the
Cover). Next, the main power must be reconnected while the cover is removed.
Care must be taken to not touch any electrical components under or near
the guards on the main power supply or the deuterium lamp power supply
as high voltages exist in these regions. Also, avoid dropping tools or other
metal objects that could cause electrical shorts in the spectrophotometer
electronics.
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Switch on the spectrometer power and initialize. There is a lamp adjust utility
that is accessed from the Configure screen from the Main panel Operate menu.
Once the spectrometer is initialized, two additional buttons on the Configure
screen become active for adjusting the deuterium and tungsten lamps. When
pressed, a lamp adjustment window appears (see Figure 14-1) with a bar scale
that monitors the intensity of the particular lamp. The bar is blue when the
intensity is too low, green when it is in an acceptable range, and red when the
intensity is too high. Locate the appropriate lamp intensity adjustment screw (see
Figure 14-2 and Figure 14-3) and adjust the lamp so that the bar is closest to the
top of the bar scale while it is still green. At this point, the lamp intensity should
be adjusted such that the detector is never over ranged, yet a minimum
acquisition time is required.

Figure 14-1 Lamp Adjustment Window
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The same Allen wrench used to lock the fiber optic probe ferrules in the
spectrometer is used for the intensity adjustment screw (see Figure 14-2). The
adjustment screw is self-locking, and is somewhat more difficult to turn than the
probe setscrews. Turn the screw in or out to adjust the intensity.

Lamp intensity
adjustment screw
Fiber optic clamp screw

Figure 14-1 Deuterium lamp intensity adjust
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14.2 Tungsten lamp intensity
The tungsten lamp intensity is adjusted by rotating a flag into the path of the lamp
output (see Figure 14-3). The exposure is very sensitive to the flag rotation. The
hex head adjustment screw will rotate the flag; a correct size hex wrench was
supplied with the instrument. The flag should have enough rotating resistance to
stay in place.

Intensity adjustment screw

Adjustment flag tension
screw (no adjustment
necessary)

Figure 14-2 Tungsten Lamp Adjustment Flag and Screw

14.3 Tungsten Lamp Replacement
Touching the replacement lamp envelope with the hands during installation can
cause premature failure. Replacement lamps are shipped with a plastic or paper
cover over the envelope to protect them from being touched. Do not remove this
cover until the lamp is installed in the socket, and ready for installation in the
lamp housing. If the lamp envelope is accidentally touched, clean it with
absorbent lens tissue moistened with isopropyl alcohol.
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The AC power must be disconnected and the spectrometer cover must be
removed as described in Section 5.1. The tungsten lamp housing on the main
power supply circuit board, is located to the left of the main power supply
transformer as shown Figure 14-4. The tungsten lamp is retained in the housing
with a spring-loaded clamp. Grasp the clamp at the hook in the clamp stem
between the two springs and lift straight up to release.
Lamp socket (shown partially removed)
Clamp (shown lifted)

Lamp Housing

Lamp current indicator

Fiber optic locking setscrew

Lamp current
adjustment trimpot
Shutter/photodiode mount
Figure 14-3 Tungsten Lamp Housing Location

Grasp the lamp socket leads and pull the lamp socket from the housing. Pull the
lamp from the socket and discard.
Install the replacement lamp in the socket, remove the protective cover, and then
set the lamp into place in the housing while again pulling up on the clamp.
Before releasing the clamp, make sure that the lamp is properly seated in the
housing such that the bulb is not damaged. Gently release the clamp to secure
new lamp.
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14.4 Adjusting Tungsten Lamp Current
In the event that the tungsten lamp may need adjustment or is removed and reinstalled for any reason, the lamp current set point must be adjusted. This is
performed by adjusting a trimpot until a LED indicates the proper lamp current.
The lamp current is adjusted with the spectrometer cover removed, and power
applied. Make sure that the tungsten lamp is illuminated and the deuterium lamp
is off before proceeding. Locate the lamp current adjustment trimpot and the
lamp current indicator LED (see Figure 14.4). Use a trimpot adjustment tool to
turn the trimpot clockwise until the LED is illuminated. Next, turn the trimpot
counterclockwise until the LED just becomes fully extinguished. When the lamp
current indicator is not illuminated, the lamp current is being regulated at the
correct level by an optical feedback circuit.
This trimpot is NOT meant for adjusting the lamp intensity. Before placing the
unit in service, if necessary adjust the lamp intensity as described in Section 0.

14.5 Deuterium Lamp Replacement
The AC power must be disconnected and the spectrometer cover must be
removed as described in Section 5.1. Locate the deuterium lamp electrical
connector near the right side of the lamp power supply transformer as shown in
Figure 14.5. There is a latch on the right side. Press the top of the latch towards
the connector body to release it, then pull straight up on the connector to detach
it from the printed circuit board.
The deuterium lamp is held in its housing by two screws located on top of the
lamp mount as shown in Figure 14.5. Use a small, flat blade screwdriver to
remove these two screws. The lamp can now be lifted from the spectrometer
and disposed. Install a new lamp by reversing the procedure above. No optical
alignment is necessary.
If necessary before placing the unit in service, adjust the lamp intensity as
described in Section 14.1.1.
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Deuterium lamp
electrical connector

Connector Latch
Lamp mount
screws

Deuterium lamp
electrical socket

Lamp intensity
adjustment screw
Fiber optic clamp screw

Figure 14-4 Deuterium Lamp Housing and Electrical Connector

14.6 Lamp Warm Up Times
Both tungsten and deuterium lamps require a warm up period of approximately 1
hour before they reach maximum stability, but for routine use, 30 minutes may be
sufficient. The lamp warm up time is independent of the time necessary for the
spectrograph temperature to stabilize. This is especially important to remember
if the deuterium lamp is not turned on when the instrument is first powered up. If
either lamp has not had sufficient warm up time, baseline drift will be observed.
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15. Specifications
Performance

Model 410

Model 420

Model 430

Model 440

Wavelength
Range

350-950 nm

200-950 nm

350-980 nm

190-980 nm

Spectral
Bandwidth

1.2 nm

1.2 nm

<1.1 nm

<1.1 nm

Wavelength
Accuracy

1.2 nm

1.2 nm

<1.1 nm

<1.1 nm

Photometric
Range

0.002-3.00 AU

0.002-3.00 AU

0.002-3.20 AU

0.002-3.20 AU

Photometric
Accuracy

0.005 AU

0.005 AU

0.005 AU

0.005 AU

Baseline Stability

<0.005 AU/hour

<0.005 Au/hour

<0.005 AU/hour

<0.005 AU/hour

<0.02%

<0.02%

<0.02%

<0.02%

Warm Up Time

½ hour

½ hour

½ hour

½ hour

Dip Probe
Pathlength

~1 cm

~1 cm

~1 cm

~1 cm

Cell Holder Beam
Diameter

0.20”

0.20”

0.20”

0.20”

Size

9” x 13” x 5.5”

9” x 13” x 5.5”

9” x 13” x 5.5”

9” x 13” x 5.5”

Weight

12 pounds

15 pounds

12 pounds

15 pounds

Power

110/220 VAC
0.8A

110/220 VAC
0.8A

110/220 VAC
0.8A

110/220 VAC
0.8A

(at 300 nm and 600
nm)

Stray Light
(at 300 nm and 600
nm)

General
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16. Troubleshooting
16.1 Spectrophotometer
Messages

Initialization

and

Associate

Error

If initialization is not successful, one of three error messages will appear in dialog
boxes. The first possible error message is:
Error 37 occurred In Com Port Init.VI:
The selected COM port either does not exist or is in use by another
application. Press the CONFIGURE button to select another COM
port. Refer to user's manual for more information.
Possible reasons:
LabVIEW: Device not found.
The SI400 control application could not find the COM port you specified during
configuration. The COM port may physically exist or not, but it could not be
"found" through the Windows operating system. If another Windows application
is open which may be using the COM port, close the application. If you are sure
that the COM port physically exists, make sure that Windows knows of its
presence. A good place to start troubleshooting this problem is for Windows 95
and higher, open the System application in the Control Panel and look under
Device Manager, Ports, for the COM ports that are available.
The second error message that can occur is:
Error -1201 Occurred
Spectrometer Initialization.
Series 400 spectrophotometer is not responding to initialization
command. Verify that spectrophotometer power is switched on, and
that the communications cable is connected.
This will arise if the communications port is found on the host computer end, but
there is no response from the 400 Series Spectrophotometer when information is
sent to it. Make sure that the RS-232 cable is plugged into the spectrometer, and
to the port that you specified during configuration. Also, make sure that the
communications cable has no broken conductors. The 9 pin D male to 9 pin D
female connector cable supplied with the 400 series instruments is wired straight
through with pin 1 connecting to pin 1, pin 2 to pin 2, etc.
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A third message that can appear is:
Error -1202 Occurred
Spectrometer Init.VI.
An error has occurred while transmitting the initialization file to the
series 400 spectrometer. A likely cause is a mismatch in the
communications data rate (baud rate) settings. The computer port
baud rate must match the spectrometer baud rate. The computer
baud rate is changed using the CONFIGURE button on the main
program screen. Refer to user's manual for information about the
spectrometer baud rate.
If the COM port baud rate is correct, check the integrity of the
communications cable.
This error indicates that while there was a response from the spectrophotometer,
it was not the expected one. In addition to checking baud rates, make sure that
the COM port selection is correct. If the SI400 application is trying to
communicate with the spectrophotometer on a serial port that another device
(such as a mouse or modem) is connected, this error can result. It is also
necessary that the COM port being used is not sharing an interrupt (IRQ) with
another COM port or modem.
This error can also occur if the cable between the host computer and the
spectrophotometer is too long, or is being used in an electrically noisy
environment, or is not properly shielded. If it is necessary to use a long cable, try
to reduce the baud rate to 9,600.
Sometimes it is necessary to set the serial transmit buffer to Low in Windows 95.
This is performed in the System Properties window launched from the Control
Panel. Select the Device Manager tab; expand the Ports (COM & LPT) item;
double click on the COM port being used to display its properties. Next select
the Port Settings tab and then press the Advanced button to open the
Advanced Port Settings window. Here there are two controls, one for Receive
Buffer and one for Transmit Buffer. The Receive Buffer is normally set near High
and should be left this way. The Transmit buffer needs to be set to Low for the
most reliable communications.

16.2 Unreliable Communications
Unreliable communications can result from a number of sources, including the
computers RS-232 port, cable, and software drivers. One of the primary sources
of problems is slow computer response time that is related to how many tasks
the Windows task scheduler has in its queue. If the system can not respond to
the serial communications port sufficiently fast, characters may be occasionally
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and unpredictably dropped, resulting in errors during the spectrophotometer
initialization.
The use of a buffered serial interface port equipped with 16550 UARTs is
required, as it will collect characters internally while waiting for service from the
computer's processor. The older 8250 type UARTs has no internal buffer, and
will not work reliably. The type of UART used in a serial port can be determined
using the DOS 6.22 "MSD" command.
The use of 16550 UART equipped serial ports and high quality RS-232 cables
will result in reliable communications in nearly every situation. If communications
problems persist, contact Spectral Instrument's service department for assistance
with other solutions.
It has been found that on some notebook computers that it is necessary to turn
off the power management to obtain reliable communications. This is due to the
overhead added to the system by the power management causing some
communications to be lost.

16.3 Screen Size
The programs front panels are designed for use with at least 800 x 600 resolution
on the Windows display. If the display is set to 640 x 480, parts of the front panel
will be off the screen and it is necessary to change the resolution of the display.
See the Windows manual or Help screens for the procedure to change the
display resolution.

16.4 Lamp Intensity Warning Messages
Figure 14-1 shows what a normal Blank intensity spectrum looks like. This
spectrum will vary from one spectrometer to another and depending on where
the crossover wavelength for the UV and visible lamps is set. Here the crossover
is at 460 nm and is not optimized.
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Figure 0-1 Normal Blank intensity spectrum

16.6

High Lamp Intensity

The SI400 application will alert the user if the tungsten lamp intensity is too high
when a blank is acquired by giving the warning message:
The Tungsten source intensity is too HIGH
and must be adjusted. See the manual for
instructions.
A similar message will result from high deuterium lamp intensity. The user may
choose to either cancel the operation or continue by pressing the appropriate
buttons in the dialog box.
If either warning message occurs, turning the intensity adjustment screw
clockwise should reduce the appropriate lamp intensity (see Section 14.1).

16.7

Low Lamp Intensity

If the light intensity reaching the detector from the tungsten lamp is very low, the
warning message:
The Tungsten source intensity is too LOW
and may need to be adjusted or the lamp
is out. See the manual for instructions.
will appear. A similar message results from a low deuterium lamp intensity.
Again, the user may cancel or continue by pressing the appropriate button.
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A low intensity means that the spectrophotometer has determined that even by
increasing the readout integration time to a maximum (10 seconds for both
tungsten and deuterium sources using "normal" precision), the intensity of light
reaching the detector is so low that an unacceptable signal to noise may result.
Light may not reach the detector due to:
1) A lamp is not functioning.
2) The fiber optic probe is not installed, not sampling a blank, or very
inefficient or defective.
3) Lamp intensity adjustment screw is blocking too much light.
Check each item above in the order listed.
described in Section 14.1.

Adjust the lamp intensity as
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